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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

• Thorough knowledge of basic inventory control

• Working experience with Oracle Application Inventory and setup

Prerequisites

• There are no prerequisites for this course.

How This Course Is Organized

This is an instructor-led course featuring lecture and hands-on exercises.  Online
demonstrations and written practice sessions reinforce the concepts and skills
introduced.
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Related Publications

Oracle Publications

Title Part Number

None

Additional Publications

• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab
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(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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ObjectivesObjectives

After completing this module, you should be able
to do the following:

• Define locator control
• Define revision control
• Define lot control
• Define serial number control

After completing this module, you should be able
to do the following:

• Define locator control
• Define revision control
• Define lot control
• Define serial number control
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OverviewOverview

Flexibility:
• Inventory controls are optional for all items.
• You can implement any combination of the four

controls (locator, revision, lot and serial number)
for each item.

Flexibility:
• Inventory controls are optional for all items.
• You can implement any combination of the four

controls (locator, revision, lot and serial number)
for each item.

With Oracle Inventory you can implement locator,
revision, lot and serial number control.
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AgendaAgenda

• Defining Locator Control
• Defining Revision Control
• Defining Lot Control
• Defining Serial Number Control
• Summary

• Defining Locator Control
• Defining Revision Control
• Defining Lot Control
• Defining Serial Number Control
• Summary
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Locator Control OverviewLocator Control Overview

• Stock Locators are structures within
subinventories and are the third level in the
enterprise structuring scheme of Oracle Inventory.

• Stock Locators may represent rows, aisles, or bins
in warehouses. You can transact items directly
into and out of Stock Locators.

• Stock Locators are structures within
subinventories and are the third level in the
enterprise structuring scheme of Oracle Inventory.

• Stock Locators may represent rows, aisles, or bins
in warehouses. You can transact items directly
into and out of Stock Locators.
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Locator StructuringLocator Structuring

• You can structure your Oracle Inventory
installation so that some of the subinventories and
items have locator control while others do not.

• If Locator Control is turned on at the item level,
you must specify a locator when transacting the
item into or out of a subinventory.

• If Locator Control is turned on at the subinventory
level, you must specify a locator when transacting
any item into or out of that subinventory.

• Each Stock Locator you define must belong to a
subinventory.

• Each subinventory can have multiple Stock
Locators.

• You can structure your Oracle Inventory
installation so that some of the subinventories and
items have locator control while others do not.

• If Locator Control is turned on at the item level,
you must specify a locator when transacting the
item into or out of a subinventory.

• If Locator Control is turned on at the subinventory
level, you must specify a locator when transacting
any item into or out of that subinventory.

• Each Stock Locator you define must belong to a
subinventory.

• Each subinventory can have multiple Stock
Locators.

For detailed information on setting up Locator Control, use the following online
help navigation path:
(Help) Oracle Manufacturing Applications > Oracle Inventory > Setting Up >
Inventory Structure > Defining Stock Locators
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Locator StructuringLocator Structuring

Item with locator controlItem with locator control
in this subinventoryin this subinventory

Locator

Subinventory

Item without locator controlItem without locator control
in this subinventoryin this subinventory

Subinventory

OrganizationOrganization
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Locator StructuringLocator Structuring

• You can restrict the life of any given Stock Locator
by assigning an Inactive On date.

• You can limit a Stock Locator by Volume,
including size and weight.

• You can limit a Stock Locator by Dimensions,
including Height, Width and Length.

• You can restrict specific item numbers to a
specific Stock Locator.  For example you may
stock an item that is too large to fit into a standard
locator. You can specify this item to be stocked in
an oversized locator only.

• You can restrict the life of any given Stock Locator
by assigning an Inactive On date.

• You can limit a Stock Locator by Volume,
including size and weight.

• You can limit a Stock Locator by Dimensions,
including Height, Width and Length.

• You can restrict specific item numbers to a
specific Stock Locator.  For example you may
stock an item that is too large to fit into a standard
locator. You can specify this item to be stocked in
an oversized locator only.
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Locator Control ReportsLocator Control Reports

• Locator Quantities Report• Locator Quantities Report

Oracle Inventory provides the following inquiries and
reports for tracking locators:

You can transact item quantities to Stock Locators
and track the movements of items at the Stock
Locator level.  Use the Locator Quantities Report to
identify items and their quantities stored in the
specified Stock Locators.  If the Stock Locator has
zero on hand quantity, the locator does not print.
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• Locator Listing• Locator Listing

Use the Locator Listing Report to list Stock
Locators you have defined.  You can also use this
report to review volume and weight allowed in a
location before transacting items.

Locator Control ReportsLocator Control Reports
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Practice 1 OverviewPractice 1 Overview

• Create a new item
• Perform a Miscellaneous Receipt into a locator

controlled subinventory
• Review the resulting on-hand quantities

• Create a new item
• Perform a Miscellaneous Receipt into a locator

controlled subinventory
• Review the resulting on-hand quantities
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Practice 1 SolutionPractice 1 Solution

Practice 1 Solutions
1.  Create a new item using the format that your instructor assigns to you.
Description=Locator Control
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Items > Master Items
Save.
Assign your new item to the M1 Organization.
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Items > Master Items > Tools > Organization Assignment
Save.
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Practice 1 SolutionPractice 1 Solution

Practice 1 Solutions
2.  Perform a Miscellaneous Receipt into a locator controlled subinventory that
has been specified by your instructor.
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Transactions > Miscellaneous Transactions
Type=Miscellaneous Receipt
(B)Transaction Lines
Enter your item number
Select the Subinventory and Locator that your instructor assigns
UOM= EA
QTY= 10
Account= Miscellaneous (using the List of Values)
Save.
3.  Review the resulting on-hand quantities
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > On-hand, Availability > On-hand Quantity
Enter your item number
select the “Detailed” option.
(B)Find
Review the Quantity in the Subinventory and Locator that you specified during
the Miscellaneous Receipt.
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AgendaAgenda

• Defining Locator Control
• Defining Revision Control
• Defining Lot Control
• Defining Serial Number Control
• Summary

• Defining Locator Control
• Defining Revision Control
• Defining Lot Control
• Defining Serial Number Control
• Summary



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Inventory Controls
Chapter 1 - Page 16

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Revision Control OverviewRevision Control Overview

• A revision is a particular version of an item, bill of
material, or routing.

• By using the revision quantity control option you
track item quantities by item revision.  To do so
you must specify a revision for each material
transaction.

• You enable revision quantity control for items for
which you must track version changes or changes
that are significant enough to track but are not
affecting the function and feature of the item and
therefore do not require an item change.

• A revision is a particular version of an item, bill of
material, or routing.

• By using the revision quantity control option you
track item quantities by item revision.  To do so
you must specify a revision for each material
transaction.

• You enable revision quantity control for items for
which you must track version changes or changes
that are significant enough to track but are not
affecting the function and feature of the item and
therefore do not require an item change.
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Revision Control OverviewRevision Control Overview

You cannot change the Revision Control item
attribute when an item has quantity on hand.  If
Revision Control is controlled at the Master Item
level, the check for on-hand quantity is against the
sum of on-hand quantities in all child
organizations.

You cannot change the Revision Control item
attribute when an item has quantity on hand.  If
Revision Control is controlled at the Master Item
level, the check for on-hand quantity is against the
sum of on-hand quantities in all child
organizations.
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Revision ControlRevision Control

Item # AS54888 
Revision A

Item # AS54888
Revision B
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Revision ControlRevision Control

• When defining Revision numbers you can use
letters, numbers and characters such as A, A1, 2B,
etc.

• Letters are always in upper case and numbers may
include decimals.

• To ensure that revisions sort properly, decimals
should always be followed by a number.

• Revisions are sorted according to ASCII rules.
• Each revision must be greater than the previous

revision.  For example, you cannot use revision 10
after revision 9 because, according to ASCII
sorting, 10 precedes 9.

• When defining Revision numbers you can use
letters, numbers and characters such as A, A1, 2B,
etc.

• Letters are always in upper case and numbers may
include decimals.

• To ensure that revisions sort properly, decimals
should always be followed by a number.

• Revisions are sorted according to ASCII rules.
• Each revision must be greater than the previous

revision.  For example, you cannot use revision 10
after revision 9 because, according to ASCII
sorting, 10 precedes 9.
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Revision ControlRevision Control

• The value entered in the Starting Revision field in
the Organization Parameters window displays as
the starting revision for the item when assigning
revisions to an item.

• For items that have the same revision date, the
revisions sort in descending order starting with
the last revision you entered.

• The value entered in the Starting Revision field in
the Organization Parameters window displays as
the starting revision for the item when assigning
revisions to an item.

• For items that have the same revision date, the
revisions sort in descending order starting with
the last revision you entered.

For detailed information on setting up Revision Control, use the following online
help navigation path:
(Help) Oracle Manufacturing Applications > Oracle Inventory > Items > Defining
Item Revisions
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Practice 2 OverviewPractice 2 Overview

• Enter a new item and assign Revision Control.
• Perform a Miscellaneous Receipt and view the

resulting on-hand quantities.

• Enter a new item and assign Revision Control.
• Perform a Miscellaneous Receipt and view the

resulting on-hand quantities.
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Practice 2 SolutionPractice 2 Solution

Practice 2 Solutions
1.  Create a new item using the format that your instructor assigns to you.
Description=Revision Control
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Items > Master Items
Save.
Assign your new item to the M1 Organization.
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Items > Master Items > Tools > Organization Assignment
Save.
2. Select the Inventory Tab.
Select the Revision Control box.
Save.
3.  Assign two revisions to your item.
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Items > Organization Items > Tools > Revisions
Revision A Effective date is today’s date.
Revision B Effective date is one month from today
Save
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Practice 2 SolutionPractice 2 Solution

Practice 2 Solutions
4. Perform a Miscellaneous Receipt.
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Transactions > Miscellaneous Transactions
Type=Miscellaneous Receipt
(B)Transaction Lines
Enter your item number.
Using the List of Values, select a Revision
Select the Subinventory and Locator that your instructor assigns.
UOM= EA
QTY= 5
Account= Miscellaneous (using the List of Values)
Save.
5. Review the resulting on-hand quantities
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > On-hand, Availability > On-hand Quantity
Enter your item number
select the “Detailed” option.
(B)Find
Review the Revision, Quantity , Subinventory and Locator that you specified
during the Miscellaneous Receipt.



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Inventory Controls
Chapter 1 - Page 24

Agenda

Copyright  Oracle Corporation, 2000. All rights reserved.
®

AgendaAgenda

• Defining Locator Control
• Defining Revision Control
• Defining Lot Control
• Defining Serial Number Control
• Summary

• Defining Locator Control
• Defining Revision Control
• Defining Lot Control
• Defining Serial Number Control
• Summary
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Lot Control OverviewLot Control Overview

Lot#032698

• Oracle Inventory provides complete lot number
support for inventory transactions.

• A lot identifies a specific batch of an item that you
receive and store in your organization.

• Lot control is a  technique for enforcing the use of
lot numbers during material transactions, thus
enabling the tracking of batches of items
throughout their movement in and out of
inventory.

• If Lot Control is turned on for an item, you must
indicate the lot number to perform a transaction.

• Oracle Inventory provides complete lot number
support for inventory transactions.

• A lot identifies a specific batch of an item that you
receive and store in your organization.

• Lot control is a  technique for enforcing the use of
lot numbers during material transactions, thus
enabling the tracking of batches of items
throughout their movement in and out of
inventory.

• If Lot Control is turned on for an item, you must
indicate the lot number to perform a transaction.
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Lot Control OverviewLot Control Overview

• You can enable lot control for specific items in
your inventory.

• For items under lot control, you assign lot
numbers to each receipt into inventory and
thereafter reference the same lots for each item
you perform  material transactions on.  This allows
you to have tight control over batches of items in
your inventory.

• You can enable lot control for specific items in
your inventory.

• For items under lot control, you assign lot
numbers to each receipt into inventory and
thereafter reference the same lots for each item
you perform  material transactions on.  This allows
you to have tight control over batches of items in
your inventory.
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Lot Number AssignmentLot Number Assignment

• Lot Control must be turned on at the item level.
• You must assign lot numbers whenever you

receive  items under lot control into inventory.
• You can split an inventory receipt in to several

lots, as necessary.
• You can add quantities to existing lot numbers.
• Oracle Inventory will generate default lot numbers

by using the default lot number generation method
which is configured in the Organization
Parameters window during setup.

• Lot Control must be turned on at the item level.
• You must assign lot numbers whenever you

receive  items under lot control into inventory.
• You can split an inventory receipt in to several

lots, as necessary.
• You can add quantities to existing lot numbers.
• Oracle Inventory will generate default lot numbers

by using the default lot number generation method
which is configured in the Organization
Parameters window during setup.

For detailed information on setting up Lot Control, use the following online help
navigation path:
(Help) Oracle Manufacturing Applications > Oracle Inventory > Items > Lot and
Serial Number Control > Setting Up Lot Control
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Lot Number AssignmentLot Number Assignment

• When you complete an assembly under lot control
into inventory, you must assign a lot number in
the WIP Completion Transaction form in Oracle
Work in Process.

• For assembly completions on discrete jobs, Oracle
Work in Process defaults the job’s lot number.

• When you complete an assembly under lot control
into inventory, you must assign a lot number in
the WIP Completion Transaction form in Oracle
Work in Process.

• For assembly completions on discrete jobs, Oracle
Work in Process defaults the job’s lot number.
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Lot Number PurgingLot Number Purging

• You can purge all lot transaction information from
your current organization. The transactions must
be in closed accounting periods.

• Purging lot transactions eliminates information
used in lot reports and inquiries.

• You can purge all lot transaction information from
your current organization. The transactions must
be in closed accounting periods.

• Purging lot transactions eliminates information
used in lot reports and inquiries.
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Maintaining Lot InformationMaintaining Lot Information

• You can use the Item Lots window to update the
expiration date of lots for items under lot
expiration (shelf-life) control.

• Inventory lets you view all lots you created in your
current organization and the supplier lot
information associated with them.

• If you attempt to transact an item, to or from an
expired lot, Inventory displays a warning but does
not prevent you from using the lot.

• You can use the Item Lots window to update the
expiration date of lots for items under lot
expiration (shelf-life) control.

• Inventory lets you view all lots you created in your
current organization and the supplier lot
information associated with them.

• If you attempt to transact an item, to or from an
expired lot, Inventory displays a warning but does
not prevent you from using the lot.
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Lot ExpirationLot Expiration

• You can determine whether a lot has an expiration
date by assigning a number of lot control shelf life
days or by entering a lot expiration date.

• The expiration date controls the availability of the
lot for transacting and planning purposes.

• You can determine whether a lot has an expiration
date by assigning a number of lot control shelf life
days or by entering a lot expiration date.

• The expiration date controls the availability of the
lot for transacting and planning purposes.
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Lot ExpirationLot Expiration

• is not considered as on-hand supply when
performing min-max, reorder point or MRP
planning calculations.

• cannot be reserved for a date beyond the
expiration date.

• can be transacted and is included in on-hand
quantities.

• is included in all inquiries and reports.
• is included in a cycle count and count entry and

adjustments are allowed.
• is included in a physical inventory and tag entry

and adjustments are allowed.

• is not considered as on-hand supply when
performing min-max, reorder point or MRP
planning calculations.

• cannot be reserved for a date beyond the
expiration date.

• can be transacted and is included in on-hand
quantities.

• is included in all inquiries and reports.
• is included in a cycle count and count entry and

adjustments are allowed.
• is included in a physical inventory and tag entry

and adjustments are allowed.

An expired lot:
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Cycle Counts Under Lot ControlCycle Counts Under Lot Control

• The cycle count listing includes the lot numbers of
the items to be cycle counted.

• You must assign lot numbers to all items under lot
control for which you enter counts.

• If there is a difference between the Cycle Count
quantity and the system on-hand quantity,
Inventory adjusts the item quantity in that lot.

• The cycle count listing includes the lot numbers of
the items to be cycle counted.

• You must assign lot numbers to all items under lot
control for which you enter counts.

• If there is a difference between the Cycle Count
quantity and the system on-hand quantity,
Inventory adjusts the item quantity in that lot.
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Physical Inventory Under Lot ControlPhysical Inventory Under Lot Control

• Inventory includes the lot numbers of the items to
count in your physical inventory when generating
tags.

• You must assign lot numbers to all items under lot
control for which you enter counts in the Physical
Inventory Tag Counts window.

• If there is a difference between the count quantity
and the system on-hand quantity, Inventory
adjusts the item quantity in that lot.

• Inventory includes the lot numbers of the items to
count in your physical inventory when generating
tags.

• You must assign lot numbers to all items under lot
control for which you enter counts in the Physical
Inventory Tag Counts window.

• If there is a difference between the count quantity
and the system on-hand quantity, Inventory
adjusts the item quantity in that lot.
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Disabled LotsDisabled Lots

• Disabling a lot only prevents it from appearing in a
list of values when performing receipt
transactions.

• A lot number is valid and accepted when typed in
even though it does not appear in the list of
values.

• Disabling a lot only prevents it from appearing in a
list of values when performing receipt
transactions.

• A lot number is valid and accepted when typed in
even though it does not appear in the list of
values.



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Inventory Controls
Chapter 1 - Page 36

Disabled Lots

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Disabled LotsDisabled Lots

• is included in available to transact, available to
promise and available to reserve calculations.

• is included as on-hand supply when performing
min-max, reorder point or MRP planning
calculations.

• is included as on-hand in all inquiries and reports,
including inventory valuation reports.

• can be transacted with Inventory functions and the
Transaction Open Interface.

• can be reserved.

• is included in available to transact, available to
promise and available to reserve calculations.

• is included as on-hand supply when performing
min-max, reorder point or MRP planning
calculations.

• is included as on-hand in all inquiries and reports,
including inventory valuation reports.

• can be transacted with Inventory functions and the
Transaction Open Interface.

• can be reserved.

A disabled lot:
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Lot Control ReportsLot Control Reports

• Lot Transactions Register• Lot Transactions Register

Oracle Inventory provides the following inquiries and
reports for tracking serial numbers:

You can use the Lot Transactions Register to report
Comprehensive lot number material transaction detail
within a specific date range.  You can run the report
for a range of lots, items, transaction types,
transaction reasons and subinventories.  You can
also specify a specific category set and display
transaction quantities in their primary or transacted
unit of measure.
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Lot Control ReportsLot Control Reports

• Supplier Lot Trace Report• Supplier Lot Trace Report

You can use the Supplier Lot Trace Report to trace a
specific lot to its supplier lots.  You can run the report
for a range of lot numbers and items and a specific
supplier lot number.  The report shows you the lot
material transactions related to the selected items
and prints inventory items, lot numbers, transaction
dates and transaction quantities.
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Lot Control ReportsLot Control Reports

• Expired Lots Report• Expired Lots Report

You can use the Expired Lots Report to show lots in
your organization that expire on or before the date
you specify.  You can run the report for a range of
items or for a specific item only.
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Practice 3 OverviewPractice 3 Overview

• Select a Lot number for an item while performing a
Miscellaneous Receipt and assign the item to a
locator controlled subinventory.

• View the resulting on-hand quantities.

• Select a Lot number for an item while performing a
Miscellaneous Receipt and assign the item to a
locator controlled subinventory.

• View the resulting on-hand quantities.
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Practice 3 SolutionPractice 3 Solution

Practice 3 Solutions
1.  Create a new item using the format that your instructor assigns to you.
Description=Lot Control
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Items > Master Items
Save.
Assign your new item to the M1 Organization.
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Items > Master Items > Tools > Organization Assignment
Save.
2.  Select the Inventory Tab
Under Lot Control,  select “Full Lot Control” in the pull down box.
Save
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Practice 3 SolutionPractice 3 Solution

Practice 3 Solutions
3. Perform a Miscellaneous Receipt into a locator controlled subinventory that has
been specified by your instructor and assign a lot number.
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Transactions > Miscellaneous Transactions
Type=Miscellaneous Receipt
(B)Transaction Lines
Enter your item number
Select the Subinventory and Locator that your instructor assigns
UOM= EA
QTY= 5
Account= Miscellaneous (using the List of Values for Account Alias)
(B)Lot/Serial
(B)Generate
QTY= 5
(B)Done
Save
4.  View the resulting on-hand quantity
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > On-hand, Availability > On-hand Quantity
Enter your item and click the “Detailed” option.
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(B)Find.
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AgendaAgenda

• Defining Locator Control
• Defining Revision Control
• Defining Lot Control
• Defining Serial Number Control
• Summary

• Defining Locator Control
• Defining Revision Control
• Defining Lot Control
• Defining Serial Number Control
• Summary
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Serial Number OverviewSerial Number Overview

• A serial number is an alphanumeric piece of
information that you assign to an individual unit of
an item.  A serialized unit is a combination of an
item number and a serial number.

• You track individual units of items by using serial
numbers. Serial number control is a system
technique for enforcing the use of serial numbers
during a material transaction.  You can use serial
numbers to track items over which you want to
maintain very tight control.

• You assign one serial number per unit of an item.

• A serial number is an alphanumeric piece of
information that you assign to an individual unit of
an item.  A serialized unit is a combination of an
item number and a serial number.

• You track individual units of items by using serial
numbers. Serial number control is a system
technique for enforcing the use of serial numbers
during a material transaction.  You can use serial
numbers to track items over which you want to
maintain very tight control.

• You assign one serial number per unit of an item.
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Generating Serial NumbersGenerating Serial Numbers

• If No Control is specified as the serial number
control type, no serial number control will be
enforced.

• If Predefined is specified as the serial number
control type, you must predefine serial numbers
for that item.

• If control At inventory receipt  or At sales order
issue, you can optionally predefine serial numbers
for the item.

• If No Control is specified as the serial number
control type, no serial number control will be
enforced.

• If Predefined is specified as the serial number
control type, you must predefine serial numbers
for that item.

• If control At inventory receipt  or At sales order
issue, you can optionally predefine serial numbers
for the item.

Depending on how you set up your Serial Number
Control at the Master Item level will determine how
you generate you serial numbers.

For detailed information on setting up Serial Number Control, use the following
online help navigation path:
(Help) Oracle Manufacturing Applications > Oracle Inventory > Items > Lot and
Serial Number Control > Setting Up Serial Number Control
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Generating Serial NumbersGenerating Serial Numbers

• Oracle Inventory uses the starting serial number
prefix and the starting serial number you specify
in the Item window to load the number of
predefined serial numbers you request.

• You can load as many serial numbers as you want
for any item under serial number control.

• The process of generating serial numbers is done
through a concurrent report.  This process does
not assign numbers to units in inventory, it simply
reserves specific serial numbers for an item, for
later use.

• Oracle Inventory uses the starting serial number
prefix and the starting serial number you specify
in the Item window to load the number of
predefined serial numbers you request.

• You can load as many serial numbers as you want
for any item under serial number control.

• The process of generating serial numbers is done
through a concurrent report.  This process does
not assign numbers to units in inventory, it simply
reserves specific serial numbers for an item, for
later use.
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Maintaining Serial NumbersMaintaining Serial Numbers

• You can use the Serial Numbers window to update
supplier information associated with your serial
numbers.

• You can view all serial numbers you created in
your current organization.

• You can view location and status information and
update supplier information associated with your
serialized units.

• You can use the Serial Numbers window to update
supplier information associated with your serial
numbers.

• You can view all serial numbers you created in
your current organization.

• You can view location and status information and
update supplier information associated with your
serialized units.
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Serial GenealogySerial Genealogy

Oracle’s Serial Genealogy:
• Enables you to view the composition and

transaction history of a serial-controlled item
through a graphical user interface.

• Includes all material transactions within an
organization.

• Enables you to trace serial numbers from an
assembly to all components.

• Enables you to trace serial numbers from a
component to a final assembly.

Oracle’s Serial Genealogy:
• Enables you to view the composition and

transaction history of a serial-controlled item
through a graphical user interface.

• Includes all material transactions within an
organization.

• Enables you to trace serial numbers from an
assembly to all components.

• Enables you to trace serial numbers from a
component to a final assembly.



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Inventory Controls
Chapter 1 - Page 50

Serial Number Control Reports

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Serial Number Control ReportsSerial Number Control Reports

• Serial Number Transactions Register• Serial Number Transactions Register

Oracle Inventory provides the following inquiries and
reports for tracking serial numbers:

You can use the Serial Number Transactions Register
to report comprehensive serial number material
transaction detail within a specific date range.  You
can run the report for a range of serial numbers,
items, transaction types, transaction reasons and
subinventories.  You can also specify a specific
category set and display transaction quantities in
their primary or transacted unit of measure.
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Serial Number Control ReportsSerial Number Control Reports

• Serial Number Detail Report• Serial Number Detail Report

You can use the Serial Number Detail Report to report
on information about current serialized units in your
organization for a specific source type and/or
serialized unit status.  Oracle Inventory lets you run
the report for a range of serial numbers, items,
suppliers and supplier serial numbers.
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Practice 4 OverviewPractice 4 Overview

• Assign a serial number  to a an item while
performing a Miscellaneous Receipt and assign
the item to a locator controlled subinventory.

• View the resulting on-hand quantities.

• Assign a serial number  to a an item while
performing a Miscellaneous Receipt and assign
the item to a locator controlled subinventory.

• View the resulting on-hand quantities.
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Practice 4 SolutionPractice 4 Solution

Practice 4 Solutions
1.  Create a new item using the format that your instructor assigns to you.
Description=Serial Control
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Items > Master Items
Save.
Assign your new item to the M1 Organization.
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > Items > Master Items > Tools > Organization Assignment
Save.
2. Under Serial Control,  select “At Receipt” in the pull down box.
Enter a Starting Prefix.
Enter a Starting Number.
Save.
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Practice 4 SolutionPractice 4 Solution

Practice 4 Solutions
3.  Generate Serial Numbers to be used with your item.
Manufacturing and Distribution Manager Responsibility   (N)
Inventory > On-Hand, Availability > Generate Serial Number
Enter your item.
(B)OK
Quantity=50
(B)OK
(B)Submit
Oracle Inventory will generate 50 serial numbers to be used for your item.
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Practice 4 SolutionPractice 4 Solution

Practice 4 Solutions
4. Perform a Miscellaneous Receipt into a Locator Controlled Subinventory and
assign serial numbers to your item.
Manufacturing and Distribution Manager Responsibility 
(N) Inventory > Transactions > Miscellaneous Transactions
Type=Miscellaneous Receipt
(B)Transaction Lines
Enter your item number.
Select the Subinventory and Locator that your instructor assigns.
UOM= EA
QTY= 5
Account= Miscellaneous (using the List of Values for Account Alias)
(B)Lot/Serial
Select the list of values under “Starting Serial Number”.
Select your Starting Serial Number.
Your Ending Serial Number will default.
(B) Done
(B) Done
Save.
5.  View the resulting on-hand quantity
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Manufacturing and Distribution Manager Responsibility   (N)
Inventory > On-hand, Availability > On-hand Quantity
Enter your item and click the “Detailed” option.
(B)Find.
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AgendaAgenda

• Defining Locator Control
• Defining Revision Control
• Defining Lot Control
• Defining Serial Number Control
• Summary

• Defining Locator Control
• Defining Revision Control
• Defining Lot Control
• Defining Serial Number Control
• Summary
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SummarySummary

• Define Locator Control, including the structuring
of Locator Control and the restrictions available
under Locator Control.

• Define Revision Control, including default
revisions and effectivity dates.

• Define Lot Control, including assigning lot
numbers, expiration dates and reporting on Lot
Controlled items.

• Define Serial Number Control, including assigning
serial numbers, Serial Number Genealogy and
reporting on items under Serial Number control.

• Define Locator Control, including the structuring
of Locator Control and the restrictions available
under Locator Control.

• Define Revision Control, including default
revisions and effectivity dates.

• Define Lot Control, including assigning lot
numbers, expiration dates and reporting on Lot
Controlled items.

• Define Serial Number Control, including assigning
serial numbers, Serial Number Genealogy and
reporting on items under Serial Number control.

You should now be able to do the following:
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